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Introduction
Thank you for purchasing this piece of Yamaha software.

With XG Editor for Mac V2.0,you can use your Macintosh to edit the main XG parameters, receive data, and
so on. You can easily edit the sounds and effects parameters of your XG tone generator and send this data
to your sequencer or module using SMF, XF and other song data formats.

Please read this Owner’s Manual to get the most out of XG Editor for Mac V2.0. Once you’ve read this
manual, keep it in a safe place so that you can refer to it whenever you need clarification on any points
you’re unclear about.

• All copyrights for XG Editor for Mac V2.0 and this Owner’s Manual are the property of Yamaha Corporation.

• Neither XG Editor for Mac V2.0 nor this Owner’s Manual may be reproduced or modified in any way, in part or in full, without the prior
consent of the Yamaha Corporation.

• Yamaha Corporation makes no representations or warranties regarding the use of XG Editor for Mac V2.0 and this Owner’s Manual and
cannot be held responsible for the results of their use.

• The screen images contained in the Owner’s Manual are for instructional purposes only, and may differ from the actual screen images
you see on your computer.

• Partial changes in the functions and specifications of this application or system software through version upgrades will be announced
separately.

Copying of the commercially available song and audio data without prior permission is strictly
prohibited unless it is for personal use. When using this data, please consult someone who is an
expert in copyright law.

• Macintosh is a trademark of Apple Computer.

• MU128 is the name of a Yamaha tone generator.

• OMS is a trademark of Opcode Systems.

• Any other company names or brand names referred to in this Owner’s Manual are the trademarks or registered trademarks of their
respective owners.

This Owner’s Manual has been written assuming that the user has a sufficient understanding of how
to use the Macintosh. For information about how to use the Macintosh, please refer to the manual
that came with it.
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About XG Editor for Mac V2.0
With XG Editor for Mac (hereafter referred to as XG Editor), you can use your Macintosh to edit the main
XG parameters, receive data, and so on. You can easily edit the sounds and effects parameters of your XG
tone generator and send this data to your sequencer or module using SMF, XF and other song data formats.
XG Editor uses OMS (Open Music System) for MIDI input/output. To use XG Editor, OMS must be installed
beforehand.

Communication with External Devices

● XG Editor will recognize and allow you to edit SMF (including XF) and parameter (SYX format) files.

● It is possible to save just the XG parameters edited using XG Editor to SMF or parameter files. It is also
possible to include XG parameter data within a song file. (→P.46)

● XG parameter data edited using XG Editor are sent via OMS to the OMS-compatible sequencer.

● Depending on how OMS is configured for MIDI input/output, XG bulk dumps from the XG tone
generator to XG Editor are possible. (→P.44)

● Any changes you make to XG parameters using XG Editor can be recorded in realtime on any OMS-
compatible sequencer with internal ports. (→P.47)
On an OMS-compatible sequencer which has no internal ports, you can still record these changes in
realtime if you install the OMS IAC driver that is included with OMS. (→P.48)

● Via the clipboard, you can copy and paste XG parameters in XG Editor to/from any software that uses
the clipboard. (→P.49)

● V2.0 includes a 64-Part-compatible XGPlayer. Using both applications, you can edit XG parameters
while playing back song data. (→P.37)

About OMS (for Mac™ OS)
XG Editor uses the OMS (Open Music System) to transfer MIDI data to an external MIDI device.
OMS is a system extension that goes in the Mac™ OS System folder, designed to manage the MIDI data
stream (input & output) in a computer, to enable MIDI data transfer between MIDI software and hardware
attached to the computer. OMS is a de facto standard of the MIDI environment under the Mac™ OS, and
various music software manufacturers have released OMS-compatible sequencer and other software.

OMS has the following merits:

● As OMS-compatible MIDI applications communicate with various MIDI devices via OMS, it is no longer
necessary for you to set up multiple MIDI drivers for those applications. Thus, you can avoid conflicts
between different drivers with the same purpose (MIDI control).

● Once a Studio Setup is read in OMS, any OMS-compatible application will be aware of it, even if you
need to reconfigure the routing of the MIDI data stream or change the current Studio Setup. OMS-
compatible applications will commonly recognize the new configuration.

● You can have different Studio Setups to choose one from,to switch to a different MIDI routing (patches
between MIDI devices and software) fast and easily.

● Every time the OMS Setup application is opened, any MIDI device connected to the computer is
automatically detected, and its icon appears with a current MIDI status (channel number, port number,
patches, etc.). Once devices are configured with OMS Setup, however, you need not care too much
about the status.

● OMS can drive various MIDI interfaces, including the standard type (16 channels) and the multi-port
type (16 channels per port). If you use a multi-port type, you can control over 16 channels
simultaneously via OMS.

n For more information about OMS features, see the READ ME file included with OMS.
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Before Using XG Editor
OMS Settings
Before you can use XG Editor, OMS has to be installed and set up.
Standard setup files for various XG tone generators are included with XG Editor; use the file suited to your
tone generator. As an example, the following explains how to set up OMS for an MU128 tone generator.

How to Set Up OMS

1. First, interconnect the “TO HOST” terminal of the XG tone generator and the Macintosh serial port,

then set the “Host Select” switch to “Mac.”

2. Double-click the “OMS Setup” icon in the “OMS Applications” folder.

3. Choose “Open...” from the “File” menu and select “MU128-Modem” from within the “OMS Setup for

YAMAHA” folder.

n If you are using a 16 Part tone generator such as the QY70, select “Std.16part-Modem” or “Std.16part-Printer.”

4. Choose “Save” from the File menu. The setup for your XG tone generator is now saved as the current

studio setup.

5. Choose “Quit” from the File menu to close OMS Setup.

n XG Editor is not compatible with versions of OMS earlier than 2.0.

OMS Port Setup
Having set up OMS, you now need to start up XG Editor and set the OMS ports.

1. First, start up XG Editor by double-clicking the “XG Editor” icon in the “XG Editor for Mac V2.0” folder.

2. If AppleTalk is enabled, you will get an alert message. Click “OFF.” It will take some time for AppleTalk

to be disabled.

3. Choose “OMS Port Setup” from XG Editor’s “MIDI” menu, then select the port settings.

In the following example, the tone generator is an MU128 and its settings are applied to OMS.

MIDI In
Select “MIDI Time Piece-Modem” when connecting an XG tone
generator to the modem port.
Select “MIDI Time Piece-Printer” when connecting an XG tone
generator to the printer port.

*If you choose “XG Editor” or “MU128-1” through “MU128-4,” bulk
data cannot be received.

When monitoring by playing external keyboard connected to the
XG tone generator, set “MIDI In” to “MU128-1” and check the “Key
Thru” checkbox.

Ports “MIDI Out A” through “MIDI Out E”can each control one block
(16 Parts) of the connected tone generator.
Select ports “MIDI Out A” through “MIDI Out D” according to the
number of Parts for the tone generator and check the “On/Off”
checkbox. Do not check the checkbox for ports that are not
compatible.
For port “MIDI Out E” the sequencer’s internal ports may also be
selected. Normally, this is used for internal communications within
applications.
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• When using only an XG tone generator

Choose settings according to the number of Parts for the tone generator. The following example is for
an MU128.

MIDI Out A: Select “MU128-1” and check “On/Off.”

MIDI Out B: Select “MU128-2” and check “On/Off.”

MIDI Out C: Select “MU128-3” and check “On/Off.”

MIDI Out D: Select “MU128-4” and check “On/Off.”

MIDI Out E: Do not check “On/Off.”

• The sequence software must be loaded for its internal port to be accessible.

4. Close “OMS Port Setup” and this completes the settings.

5. If the tone generator receives data when you choose “Transmit XG System On” from the MIDI menu,

the settings are correct. (The XG mark on the tone generator should be blinking.)

n When setting up for a 16 Part tone generator, select “XG-16part” for both “MIDI In” and “MIDI Out A.”

n Lists of voices, parameter names and other such information are provided as data files in the “Profiles”
folder. Always keep this folder within the folder containing the application.

XG Editor Setup
The following explains the basic settings needed for sending parameters from XG Editor and for saving
files.
Choose “XG Editor Setup” from the MIDI menu and a dialog box will appear containing XG Editor’s
settings.

Tone Module
Choose the XG tone generator to be used. In XG Editor, any
functions, voices and effects that are not relevant to the selected
tone generator will be grayed out as appropriate.

Output Setup
Send Interval (1 to 60): Sets the interval between successive
transmissions of XG parameter data. A value of “1”gives an interval
of about 16.7 ms. This setting is valid when sending data to another
application via an OMS internal port, or when issuing a Dump
Request message for receiving XG bulk data.

Device No. (1 to 16): Must be set for System Exclusive data to be
transmitted to, and received by, the connected XG tone generator.
Match the Device No. of the XG tone generator with the number
set here.

Insert in SMF
Data Interval (1 to 255): Sets the delta time for reading SMF data,
adding XG parameters and saving. The hexadecimal equivalent of
this number is stored as the XG parameter delta time.

Display Mode
If you click the “DETAIL” button on “MULTI PART,”“DRUM” or any
Effects panel in the “Main Panel”window, the method of displaying
the Properties Dialog can be set.

If you check the “Initialize Editor by XG On”checkbox,transmitting
an XG System On message to the XG tone generator initializes all
the settings in XG Editor.

n When you exit from “XG Editor Setup”, an initialization file is created.
Thereafter,XG Editor will always take the settings from this file when starting
up.
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XG Editor Main Panel
The XG Editor features a unique interface that arranges all the parameters for your XG tone generator in
an intuitive visual format.With it you have the power to tailor your sound exactly as you like, because it
gives you easy access to all the different settings for your XG tone generator’s voices and effects.

● Units that correspond to every type of parameter in your XG tone generator are arranged in an easy-to-
grasp visual layout.

● The Part Unit displays the voice names for each XG tone generator part, together with the insertion
effects, drum setups and other settings assigned to them. Here you can also edit the voice assigned to
each part.

● In the System Unit, you can set the system parameters of your XG tone generator.

● The Drum Unit gives you control of the parameters for drum setups, and lets you assign them to any
part.

● In the Insertion 1 and 2 Units, you can set the parameters for Insertion Effects, and assign them to any
part.

● The Variation Unit is handy when you are using Variation effects as Insertion Effects.You can set the
parameters for Variation effects, and assign them to any part.

● In the Chorus and Reverb Units, you can set the parameters for Chorus and Reverb effects. Since they
are both System Effects, the settings made here will be reflected in all the parts of the XG tone generator.

● The System Variation Unit is really useful when you are using Variation effects as System Effects.You can
set the parameters for Variation effects.

● With the Equalizer Unit you can set equalizer parameters and adjust the overall tone of your XG tone
generator.

● When playing a song in XGPlayer, XG parameter settings contained within the song can be viewed or
edited in XG Editor.

● You can save your XG Editor settings separately from the song data in a special XG parameter file.

Title Bar

Toolbar

Part Unit

Variation Unit Insertion 1 Unit Insertion 2 Unit

System Unit Drum Unit Equalizer Unit

System Variation Unit

Chorus Unit

Reverb Unit
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System and Insertion Effects
To make the most of the XG Editor, we recommend that you understand something of the basic setup for
effects in an XG tone generator. We’ll begin with a simple explanation of System Effects and Insertion
Effects.

System Effects are applied equally to all of the XG tone generator parts (channels). They are effects, like
Reverb, that are used to determine the overall atmosphere of the song. Actually,by changing the effect send
level for each part, you can adjust the depth of the effect for each part.
Insertion Effects are applied exclusively to a specific part (channel), or a voice. As in the diagram, they are
used in cases such as giving the organ part a rotary speaker effect, and the guitar part an Auto Wah effect.

In the XG Editor, you can use the Reverb Unit and the Chorus Unit for System Effects, and the Insertion 1
Unit and Insertion 2 Unit for Insertion Effects. Besides them, there is the Variation Effect Unit that can be
used for either System or Insertion Effects, depending on your purpose.

n For details about the XG tone generator, see the owner’s manual that came with the XG tone generator you are using. Your
XG tone generator might not be compatible with some of the parameters in the XG Editor. For information on which
parameters are compatible with it, see the MIDI data format in its owner’s manual.

Names and Functions of Features

Toolbar
The most commonly used functions in the File, Edit, MIDI, Window and Option menus are available as
buttons. The menu equivalents for each of the buttons are listed below.

1 File Open button ........................................Same as “Open” under the File menu (→P.32)

2 File Save button ........................................Same as “Save As...” under the File menu (→P.32)

3 Insert button ............................................Same as “Insert in SMF” under the File menu (→P.32)

4 XG Editor Setup button ...............................Same as “XG Editor Setup” under the MIDI menu (→P.34)

5 OMS Port Setup button ...............................Same as “OMS Port Setup” under the MIDI menu (→P.34)

6 Keyboard button .......................................Same as “Keyboard” under the Window menu (→P.35)

7 Player button ............................................Same as “XGPlayer” under the Player menu (→P.36)

8 Transmit XG Parameter button ....................Same as “Transmit XG Parameter” under MIDI menu (→P.34)

9 Transmit XG System ON button ....................Same as “Transmit XG System ON” under MIDI menu (→P.34)

) Transmit Selectbox Data button...................Same as “Transmit Selectbox Data”under Options menu (→P.36)

! Receive XG Bulk button ..............................Same as “Receive XG Bulk” under MIDI menu (→P.34)

@ Add to Selectbox Data button......................Same as “Add To Selectbox Data” under Options menu (→P.36)

# Copy button..............................................Same as “Copy” under Edit menu (→P.33)

1 2 3 4 5 6

8 9 ) ! @ #

7

Part 1
Part 2
Part 3
Part 4
•
•
•
Part 16

Piano
Organ
Guitar
Bass
•
•
•
Strings

XG Tone Generator

Signal Flow

System Effect SpeakersInsertion Effect

Reverb, etc.

OUT L

OUT R

Rotary Speaker
Auto Wah
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Part Unit
In the Part Unit, you can set voices, and assign Variation Unit, Insertion 1 Unit, Insertion 2 Unit or Drum
Unit  settings to any part. By clicking the [DETAIL] button, you can make precise settings and do detailed
voice editing for each part.

1 [1-16], [17-32], [33-48], [49-64], [A/D (or AUDIO)] tabs
Clicking on any of the tabs changes the parts that are displayed. The parts 1-16, 17-32, 33-48, and 49-64
indicate MIDI Multi Parts. The A/D parts indicate the external audio input parts of the XG tone generator.
The AUDIO parts indicate the audio parts for the SW1000XG sound card.

2 Part
The part numbers are shown here.

3 Voice
The voice for every part is displayed here. By double-clicking on any of the voice names, you can open a
Voice List dialog and select which voice to set for each part.

n With AUDIO parts, if you double-click on the effects display in the voice column (left side display) the voice list dialog will be
opened. There you can select the effects that will be applied to each AUDIO part.

4 V (Variation)
A “V” icon will be displayed in the box here for the part that has been assigned the Variation Effects that
are set in the Variation Unit.

n You can assign Variation Effects to any single part, but only when using Variation Effects as an Insertion Effect. For information
about Insertion Effects, see page 7.

5 i1 (Insertion 1)
An “i1” icon will be displayed in the box here for the part that has been assigned the Insertion Effects that
are set in the Insertion 1 Unit.

n Depending on the XG tone generator you are using, it may not be compatible with Insertion 1 effects.

6 i2 (Insertion 2)
An “i2” icon will be displayed in the box here for the part that has been assigned the Insertion Effects that
are set in the Insertion 2 Unit.

n Depending on the XG tone generator you are using, it may not be compatible with Insertion 2 effects.

7 Dr (Drum)
A “Dr”or “D1” to “D4” icon will be displayed in the box here for each part that has been assigned a drum
setup that is set in the Drum Unit.

8 DETAIL button
Click here and the Part Properties dialog will open. The parameters you can set with this dialog will differ
according to whether the MIDI Multi Parts (1-64) or A/D (or AUDIO) Parts has been selected.

1

2

3 8

9

75
4 6
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Voice Selection with the Voice List

1. From the CATEGORY 1 list on the left side, choose the category of the voice you want to use. The names of
the instruments will appear in the CATEGORY 2 list in the center.

2. From the CATEGORY 2 list in the center, choose one of the further extract categories. The voices included
in that category will be displayed on the right side in CATEGORY 3.

n For SFX, SFX Kit, and Drum Kit in CATEGORY 1, the final voice selection can be done in CATEGORY 2, so nothing will
be displayed in CATEGORY 3.

3. Select one of the voices displayed in CATEGORY 3 on the right side.

n If you place a check in the Click monitor box at the bottom of the dialog, the sound for each voice will play when you
click the voice name, allowing you to monitor it.

4. When you click OK, the dialog box will close, and the voice you selected will become the program for that
track. To cancel choosing the voice, click on Cancel, and the dialog box will be closed without selecting a
voice.

n In the CATEGORY 1 list,VL1 and VL2 are listed. They indicate the voices of the VL-XG tone generators such as Yamaha
Virtual Acoustic Tone Generator VL70-m. If you are using a VL-XG tone generator, you can use these voices.
Depending on the XG tone generator you are using, some of these voices may not produce any sound even when
selected. For details on the voices that can be produced with your own tone generator, see the voice list in the owner’s
manual that came with it.
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Multi Part Properties Dialog
With any of the parts from 1 to 64 selected by clicking with the mouse (the Voice column of the part will be
yellow), click on the Detail button and the properties dialog will open for the selected part. The Multi Part
Properties dialog has two screens: the Detail screen where you can make detailed settings for each parameter,
and the Quick Edit screen, where settings can be made quickly in a graphical format. The Detail screen will
display if “DETAIL” is selected as the display mode in the [XG Editor Setup] item on the [MIDI] menu. The Quick
Edit screen will display if “QUICK” is selected.

● Quick Edit Screen
A set of basic parameters in the MIDI Parameter Change table (MULTI PART) for the XG tone generator can be
graphically set using this screen.

1 PART No. (Part Number)
The number for the part that is currently the target for editing is displayed. At first, the number for the part that
was selected when the Quick Edit screen was opened will be displayed. The part that is the target for editing can
be switched using the buttons marked BLOCK A-D and the PART 1 through 16 buttons immediately to the right
of the part number.

2 BLOCK/PART buttons
By combining these two types of buttons, you can switch between parts 1 through 64, and select the part you
will be editing. BLOCK A/PART 1-16 correspond to parts 1-16, BLOCK B/PART 1-16 to parts 17-32, BLOCK
C/PART 1-16 to parts 33-48, and BLOCK D/PART 1-16 to parts 49-64.

3 DETAIL button
Clicking the DETAIL button switches to the DETAIL screen, where you can do more detailed editing.

4 VOICE LIST button
Clicking here displays the Voice List dialog. You can change the voice for the selected part. The selected voice
name will be displayed in the voice name display box below the keyboard display.

n To learn how to use the Voice List dialog, see page 9.

5 POLY/MONO buttons
When [POLY] is clicked, the system will enter poly mode,and performance with chords will be possible. Clicking
[MONO] enters mono mode, and only monophonic performance will be possible. Use this mode for situations
such as when portamento is applied to the synth lead.

2

1

4

5

6

8

9

)

7

3

^

&

*

(
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6 KEYBOARD button
By clicking the keyboard buttons you can monitor the results of your editing.

7 Voice Name display
This box displays the name of the currently selected voice.

8 Volume/Pan sliders
You can adjust the volume and orientation of the voice for this part by dragging the appropriate slider with the
mouse. The current value is displayed in the box to the left of the slider.

9 Preset Data Icon Setup box
You can set the voice for the part you are currently editing by dragging and dropping one of the preset data icons
from below into the Preset Data Icon Setup box.

) PRESET DATA
A wide variety of voices are available here as icons. In the Quick Edit screen, you can set any desired voice by
simply dragging and dropping its icon into the setup box immediately above.

n Using the scroll bar below the preset data box, you can display preset icons that are not currently visible.

! Vibrato graph
The vibrato graph is used to set the quality of vibrato applied to the part. By dragging the square mark on the
left horizontally, you can set the interval between the time when the sound itself starts and the time when the
vibrato is applied (Vibrato Delay). Dragging the center square mark vertically lets you set the degree of change
in pitch caused by vibrato (Vibrato Depth). By dragging the right-hand mark horizontally, you set the length of
one cycle of the vibrato effect (Vibrato Rate).

@ 2 Band-EQ (Equalizer) graph
This sets the tonal quality of the sound. The low sounds (Bass) are set with the square mark on the left. The high
sounds (Treble) are set with the square mark on the right. By dragging each of these square marks sideways the
frequency can be specified. Dragging them up and down sets the gain within the specified frequency.

# EG (Envelope Generator) graph
EG sets the way in which the sound is output (the way the sound is modified from start until it fades away).
Dragging the square mark on the left horizontally sets the time in which the note rises to its fullest sound (EG
Attack Time). Dragging the center square mark horizontally sets how the note is sustained while the key is held
down (EG Decay Time). Dragging the square mark on the right horizontally sets the way in which the sound
fades away after the key is released (EG Release Time).

$ Filter graph
The filter graph sets the brightness and character of the sound. By dragging the mark horizontally,you can change
the value of the cutoff frequency (Low Pass Filter Cutoff Frequency), which establishes the brightness of the
sound. Dragging the mark upward raises the volume of the frequencies around the cutoff frequency, adding
overtones (Resonance). This gives an effect like an analog synthesizer to the sound.

% Pitch EG (Pitch Envelope Generator) graph
This sets the change in pitch of the note from the time it starts until it fades away. The square mark of the left is
the setting for when the note starts. The square mark on the right is the setting for the time from when the key
is released until the note fades away. By dragging each square mark horizontally, you can set the time in which
the pitch changes (Attack and Release Time). Dragging the marks vertically sets the amount of change in pitch
(Initial and Release Level).

n On each graph described above the setting of the square mark (green) is relative to the initial value (gray) in the preset
voice.

^ SYSTEM DETAIL button
When this is clicked it opens the System Parameter dialog.

& EQ DETAIL (Equalizer Detail) button
When this is clicked it opens the EQ dialog.

* INSERTION EFFECT
This displays the insertion effects set for the part that is currently being edited. When the indicator to the side
of each box is lit, it indicates that the effect is being assigned to the part. Clicking on one of the DETAIL buttons
will open the Quick Edit screen for that effect.
and directly entering a number from the computer keyboard.
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( To System Effect
This sets the send level for each system effect from this part. It can be adjusted by dragging the sliders for Dry,
Rev Send (reverb send), Cho Send (chorus send), and Var Send (variation effect send), or by clicking the boxes
and directly entering a number from the computer keyboard.

If you are using the current variation effect as an insertion effect, it cannot be used. Clicking on one of the
DETAIL buttons will open the Quick Edit screen for that effect.

When you click on the close button at the upper-left of the window, the dialog will close and parameter setting
will be finished.

● Detail Screen
You can set every parameter for each part in the XG tone generator’s MIDI Parameter Change Table (MULTI
PART). For information about the MIDI Parameter Change Table (MULTI PART), see the MIDI data format in the
owner’s manual for your XG tone generator.

1. Select the page for the parameter item you want to set by clicking on an item name tab at the very top of
the dialog.

2. By dragging the slider for each item right and left or by clicking on radio buttons,you can set each parameter.
You can also enter settings by clicking the box to the left of each slider and typing directly from the
computer keyboard.

n For information about each parameter item page, see below.

3. When necessary, click on another item tab to switch to setting different parameter items.

4. When you click on the [Close] button, the dialog will close and parameter setting for the selected part will
be finished.

The Parameter Items pages listed below are in the Multi Part Detail screen. For details about setting values for
each parameter, see the MIDI Parameter Change Table (MULTI PART) in the owner’s manual that came with your
XG tone generator.

General ...........................................For making general settings such as voice selection, MIDI receive channel
settings, note limit (note range), and velocity sensitivity.

Pitch, Level .....................................For making settings such as each part’s note shift and volume, also effect
send level,vibrato and portamento.

Filter, EG (Envelope Generator) .........For making settings such as sound brightness and shape (how the sound
changes from the start until it fades).

EQ (Equalizer) ...............................For setting the tone.

MW, Bend (Modulation, Pitch Bend) ...For setting modulation wheel and pitch bend effects.

XG Editor.qx  3/30/99  4:11 PM  Page 12



AT (After Touch)............................For setting after touch effects. “CAT” refers to channel after touch, and
“PAT” refers to polyphonic after touch.

AC1, AC2 (Assignable Controller 1, 2)....For settings associated with assignable controller functions.

Scale ................................................For scale tuning settings.

Rcv ...................................................For setting whether or not each channel message will be received.

VL-1, VL-2........................................This is used for setting the unique Multi Part parameters for VL-XG voices.
Details are written in the owner’s manuals for VL-XG compatible tone
generators (such as the VL70-m). See the Current Voice/Common Part
Parameter or Multi Part Parameter information in the MIDI data format
section.

A/D Part Properties Dialog
With any of the A/D parts in the Part Unit selected by clicking with the mouse (the Voice column of the A/D part
will be yellow), click on the Detail button and the properties dialog will open for the selected A/D part. You can
set every parameter in the XG tone generator’s MIDI Parameter Change Table (A/D PART). For information about
the MIDI Parameter Change Table (A/D PART), see the MIDI data format in the owner’s manual for your XG tone
generator.

n If your XG tone generator doesn’t have an A/D Input function, you won’t be able to control your XG tone generator
with these parameters.

1. By dragging the slider for each item right and left or by clicking on radio buttons,you can set each parameter.
You can also enter settings by clicking the box to the left of each slider and typing directly from the
computer keyboard.

2. When you click on the [Close], the dialog will close and parameter setting for the selected A/D part will be
finished.
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XG Assignable Setup
Up to four pairs of parameters can be set up for the assignable sliders and buttons. Select the [Assignable Setup]
item on the [MIDI] menu, and the dialog box shown below will be displayed.

[1-64] and [Audio] buttons
Clicking on these buttons lets you switch between assigning parameters to Multi Part or Audio Part.

Preset Name
You can type in names here to fit the pair of parameters you have assigned to each assignable slider and button.
The names you type will be shown on the four switches to the right of the assignable sliders.

Button
Select the parameters to assign to the assignable buttons.

Slider
Select the parameters to assign to the assignable sliders.

After setting up each item by clicking and typing, click [OK]. The dialog will close and the changes you made
will be applied. If you want to cancel your changes, click on [Cancel].The dialog will close, and the settings will
remain unchanged.

9 Assignable sliders/buttons
By assigning any desired parameters in the Part Unit to sliders or buttons,you can control those parameters
for each part.Dragging the slider to the right will increase the value of the parameter assigned to the slider.
Dragging it to the left will make the value smaller. Clicking on a button to the left side of the sliders will
switch between ON and OFF for the parameter assigned to the button. (When the button is green, the
parameter is ON, when the button is black, the parameter is OFF.) You can switch between the parameters
that are assigned to the sliders and buttons by clicking one of the four switches to the right of the sliders.
To assign parameters to each of the four switches, use the Assignable Setup dialog that can be opened by
clicking on the [ASSIGN] button or selecting the “Assignable Setup” item on the “MIDI” menu.

14
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System Unit
This is used for setting system parameters for the XG tone generator. By dragging the VOL (volume),TUNE,
and KEY knobs and rotating them, you can make volume, tune and key settings for the entire XG tone
generator. You can also enter values by clicking on a box, then typing directly from the computer keyboard.
When you want to make more detailed settings, you can do it by clicking on the [DETAIL] button and
opening the System Parameter dialog.

The parameters for the System Unit are as follows:

1 VOL knob 
Sets the volume for the entire system (master volume).

2 TUNE knob 
Sets the pitch (tuning) for the entire system in 0.1 cent units. If +100 is
set, the entire system’s pitch will rise by one semitone.

3 KEY knob 
Sets the pitch (tuning) for the entire system by semitones. If +12 is set,
the entire system’s pitch will rise by one octave.

4 DETAIL button
Click here and the System Parameter dialog will open.

System Parameter Dialog
You can set the parameters in the XG tone generator’s MIDI Parameter Change Table (SYSTEM). For information
about the MIDI Parameter Change Table (SYSTEM), see the MIDI data format in the owner’s manual for your XG
tone generator.

1. By dragging the slider for each item right and left, you can change the settings in each box. You can also
enter settings by typing directly from the computer keyboard.

2. Click on the [Close] button. The dialog will close and parameter setting will be finished.

15
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Drum Unit
Used to set parameters for Drum Setups. The parameters settings made here can be assigned to any part
(that is being used as a drum part).

1 SETUP
The currently selected Drum Setup is displayed. Click on the box and a drop-down list will appear. You
can select the drum setup you want to use from the list.

n The number of drum setups you can select will depend on your XG tone generator.

2 Dr icon
By dragging this icon to the part unit and dropping it, the drum setup currently displayed in the SETUP box
can be assigned to any part. You can assign multiple parts by repeating the drag and drop operation.

n The icon (Dr or D1 to D4) displayed on the part unit will vary according to the setup (Drum or Drum S1 to S4) selected in
SETUP.

3 DETAIL button
When Drum S1-S4 are selected in the SETUP box, click here and the Drum Properties dialog will open.

Drum Properties Dialog
The Drum Properties dialog has two screens: the Detail screen where you can make detailed settings for each
parameter,and the Quick Edit screen,where settings can be made quickly in a graphical format. The Detail screen
will display if “DETAIL” is selected as the display mode in the [XG Editor Setup] item on the [MIDI] menu. The
Quick Edit screen will display if “QUICK” is selected.

● Quick Edit Screen
A set of basic parameters in the MIDI Parameter Change table (DRUM SETUP) for the XG tone generator can be
set graphically using this screen.

1 Setup 1-4 tab
Clicking one of these tabs selects the drum setup (1-4) that will be the target for editing.

2 VIEW/LIST button
Clicking the VIEW button changes to the Graph Display screen. Clicking the LIST button changes to the List
Display screen. On the Graph Display screen, parameters for the single currently specified rhythm instrument
are displayed graphically. In the List Display screen, parameters for multiple rhythm instruments are displayed as
numerical values.
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3 Rhythm Instrument Name
This box displays the name of the rhythm instrument that is currently selected as the target for editing.

4 Keyboard
Clicking one of the keys on the keyboard causes the rhythm instrument assigned to the key to be selected as the
target for editing. The settings for the currently selected rhythm instrument will be displayed graphically below.

n The rhythm instrument for each key (note number) varies according to the drum kit. For details, see the XG drum voice
list in the owner’s manual for the XG tone generator you are using.

5 Graph
Among the drum setup parameters, settings for the following are displayed here graphically: Pitch (Coarse, Fine),
Low Pass Filter (Cutoff Frequency, Resonance), EG Rate (Attack, Decay 1/2), and Output (Level, Pan). The settings
for the parameters can be changed by dragging the square marks.

Pitch:
This sets the tuning. When you drag the lower mark sideways, you can set the pitch in semitone units (Coarse).
Dragging the upper square mark sideways fine-tunes the pitch already set in semitone units (Fine).

Low Pass Filter:
This sets the brightness and character of the sound. By dragging the square mark horizontally, you can change
the value of the cutoff frequency (Low Pass Filter Cutoff Frequency), setting the brightness of the sound.
Dragging the mark upward raises the volume of the frequencies around the cutoff frequency, adding overtones
(Resonance). This gives character to the sound.

EG Rate:
This sets the way in which the sound is output (the change in the sound from its start until it fades away).
Dragging the square mark on the left horizontally sets the time in which the note rises to its fullest sound (EG
Attack Rate). By dragging the center mark horizontally, you can set the way the sound fades away (EG Decay Rate
1). By dragging the right-hand mark horizontally, you can set EG Decay Rate 2.

Output:
This sets the volume and the right and left orientation (pan). By dragging the mark horizontally, you can set the
pan. Dragging it vertically will set the volume.

n The setting of each square mark (green) is relative to the initial value (gray) in the preset voice.

6 Drum Set Illustration
The Drum Set Illustration is used for selecting the rhythm instrument that will be the target for editing. When
you are using the List Display screen, clicking on one of the rhythm instruments in the illustration will make the
cursor on the parameter list move to the rhythm instrument that was clicked. In the Graph Display screen, the
current settings for the selected rhythm instrument will be displayed on the graphs.

n When you click the picture of a rhythm instrument in the illustration, the instrument’s sound will play. Since the sound
you hear reflects the settings currently made on the Quick Edit screen, you can use it to monitor the results of your
editing efforts.

7 Kit Name
The name of the currently selected drum kit is displayed here. To change the kit, go to the part in the Part Unit
that was assigned with the Drum Setup, and change the drum voice there.

8 Parameter List
The parameter list shows the current status of all the drum settings. In the Note column on the left is displayed
the note number. Next to it in the Inst Name column is the name of the rhythm instrument that corresponds to
that note. You can change the order of the note numbers by dragging them up and down. By clicking the name
of the rhythm instrument,you can listen to it. Since the sound you hear when you click on the instrument reflects
the settings currently made on the Quick Edit screen, you can use it to monitor the results of your editing efforts.

n The rhythm instrument that corresponds to each note number will vary for each drum kit. For details, see the XG drum
voice list in the owner’s manual for the XG tone generator you are using.

17
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The parameter names for the drum setup are displayed along the top row of the list. See the MIDI Parameter
Change Table (DRUM SETUP) in the MIDI Data Format section of the owner’s manual for your XG tone generator.
When you click on a setting, a spin cursor will appear. Drag the cursor to adjust the value of that parameter.
You can also double-click on a setting and enter the value using the computer keyboard.
Among the drum setup parameters, the ones for Pitch (Coarse, Fine), Output (Level, Pan), Low Pass Filter (Cutoff
Frequency, Resonance), and EG Rate (Attack,Decay 1/2) are displayed graphically in the lower left area of the List
Display screen, the same as in the Graph Display screen. Settings for the parameters in the list can be changed
by dragging the square marks on the graph. You can change the graph that is displayed by clicking in the
parameter list on the setting for Pitch (P.Co, P.Fi), Output (Levl, Pan), Low Pass Filter (LF.Cut, LF.Res), or EG Rate
(Attk, Dec1, Dec2).

When you click on the close button at the upper-left of the window, the dialog will close and parameter setting
will be finished.

● Detail Screen
You can set parameters in the XG tone generator’s MIDI Parameter Change table (DRUM SETUP). By clicking on
the Drum-1 and Drum-2 tabs, you can change pages. For information about the MIDI Parameter Change table
(DRUM SETUP), see the MIDI data format in the owner’s manual for your XG tone generator.

1. Select the page clicking on one of the two tabs at the very top of the dialog.

2. Click on the instrument name box at the top of the parameters, and select the name of the rhythm
instrument you want to edit from the drop-down list that will be displayed.

3. By dragging the slider for each item right and left, you can set each parameter. You can also enter settings
by clicking the box to the left of each slider and typing directly from the computer keyboard.

4. Repeat steps 1, 2, 3 above as needed to set the parameters for other rhythm instruments.

5. When you click on the [Close] button, the dialog will close and parameter setting will be finished.
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Insertion 1 Unit
Used for setting parameters for Insertion Effect 1. The parameters set here can be assigned to any single
part.

1 Effect Type
The currently selected Insertion Effect 1 type is displayed. Click on the box and a drop-down list will
appear. You can select the effect type you want to use from the list.

n Depending on the XG tone generator you are using, it may not be compatible with Insertion 1 effects. Please refer to the effect
type list in the owner’s manual for your XG tone generator.

2 i1 icon
By dragging this icon to the part unit and dropping it, the currently selected effect can be assigned as an
Insertion Effect to any single part.

3 DETAIL button
Click here and the Insertion dialog will open.

Insertion Dialog
Two different screens are available in the Insertion dialog: a Detail screen where settings for each parameter can
be made very precisely, and a Quick Edit screen where you can set the parameters quickly and simply. The Detail
screen will display if “DETAIL” is selected as the display mode in the [XG Editor Setup] item on the [MIDI] menu.
The Quick Edit screen will display if “QUICK” is selected.

● Quick Edit Screen
Several of the parameters for Insertion Effect 1 can be graphically set on the Quick Edit Screen.

1 Effect Type
This displays the type of effect that is currently the target for making settings. To change the effect type displayed
here, click on the box and select the effect category you desire from the drop-down list that is displayed. A sub-
menu for that category will be displayed, and there you can choose the effect type you want.

2 Graph
The parameters for the effect currently selected will be displayed graphically on the screen. You can change the
parameter settings by dragging the square mark in the graph. The type of graph will vary according to the effect
you have selected, but regardless of the parameter you are working on, the graph has been designed to let you
work more intuitively than you could if you were just setting numerical values.

n In the graphs explained above, the value of the mark setting is expressed relative to the initial value.

3 DETAIL button
Clicking the DETAIL button opens the detail screen.
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h The Detail screen and the Quick Edit screen are linked to each other, so that settings made in either screen will be
reflected immediately on the other. If you make settings with both screens open at the same time, you can make use
of the best features of both screens and work more efficiently.

4 PART
This box displays the currently assigned part for this insertion effect. If you drag the slider below the display
box, you can change to another part.

5 DRY/WET
This sets the balance between dry and wet signals. It may not be available for use in some cases, depending on
the effect type you have selected.

6 FEEDBACK LEVEL
This sets the level at which the signal output from the unit is returned to the unit as feedback. By adjusting the
feedback level, you can create oscillation and resonance effects. This function may not be available for use in
some cases, depending on the effect type you have selected.

When you click on the close button at the upper-left of the window, the dialog will close and parameter setting
will be finished.

● Detail Screen
You can set many different parameters for Insertion Effect 1.

1. Click on the Type box at the top of the parameters, and a drop-down list will be displayed. Select the effect
type you want to edit from the list.

2. By dragging the slider for each item right and left, you can change the parameter value in each box. You can
also click on the box and enter settings by typing directly from the computer keyboard.

3. When you click on the [Close] button, the dialog will close and parameter setting will be finished.

n The parameters you can set will vary depending on the effect type. For information on each effect type and its
parameters, see the effect type list and effect parameter list in the owner’s manual that came with your XG tone
generator.
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Insertion 2 Unit
Used for setting parameters for Insertion Effect 2.
The functions and operations of the Insertion 2 Unit are the same as Insertion 1 Unit. See above.

n Depending on the XG tone generator you are using, it may not be compatible with Insertion 2 effects. Please refer to the effect
type list in the owner’s manual for your XG tone generator.

Variation Unit
Used to set effect parameters for Variation Effects when they will be used as Insertion Effects and assigned
to one of the parts.

n You can use the Variation Unit when the [INS] button on the System Variation Unit is ON. When the Variation Unit is gray and
can’t be used, click on the [INS] button on the System Variation Unit to turn it ON . (It will light up.)

1 Effect Type
The currently selected Variation Effect type is displayed. Click on the box and a drop-down list will appear.
You can select the effect type you want to use from the list.

n For information about which effect types can be selected, see the effect type list in the owner’s manual that came with your
XG tone generator.

2 V icon
By dragging this icon to the part unit and dropping it, the currently selected Variation Effect can be assigned
as an Insertion Effect to one part.

3 DETAIL button
Click here and the Variation dialog will open.

INS button
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Variation Dialog
Two different screens are available in the Variation dialog: a Detail screen where settings for each parameter can
be made very precisely, and a Quick Edit screen where you can set the parameters quickly and simply. The Detail
screen will display if “DETAIL” is selected as the display mode in the [XG Editor Setup] item on the [MIDI] menu.
The Quick Edit screen will display if “QUICK” is selected.

● Quick Edit Screen
Several of the parameters for Variation Effect can be graphically set on the Quick Edit Screen.

n Items 9 through @will be displayed only when item 5 (the SYS button) or the DETAIL button on the System Variation
Unit (→P. 24) has been clicked.

1 Effect Type
This displays the type of effect that is currently the target for making settings. To change the effect type displayed
here, click on the box and select the effect category you desire from the drop-down list that is displayed. A sub-
menu for that category will be displayed where you can choose the effect type you want.

2 Graph
The parameters for the effect currently selected will be displayed graphically on the screen. You can change the
parameter settings by dragging the square mark in the graph. The type of graph will vary according to the effect
you have selected, but regardless of the parameter you are working on, the graph has been designed to let you
work more intuitively than you could if you were just setting numerical values.

n In the graphs explained above, the value of the mark setting is expressed relative to the initial value.

3 DETAIL button
Clicking the DETAIL button opens the detail screen.

h The Detail screen and the Quick Edit screen are linked to each other, so that settings made in either screen will be
reflected immediately on the other. If you make settings with both screens open at the same time, you can make use
of the best features of both screens and work more efficiently.

4 INS (Insertion) button
When you click this button and turn it on, variation effects will be used as insertion effects. You will not be able
to use them as system effects. The layout of some parameters will be changed, and parameters for insertion
effects will be set.

5 SYS (System) button
When you click this button and turn it on, variation effects will be used as system effects. You will not be able
to use them as insertion effects. The layout of some parameters will be changed, and parameters for system
effects will be set.

6 PART
This box displays the currently assigned part for this variation effect. If you drag the slider below the display box,
you can change to another part. This can only be set when variation effects are being used as insertion effects.

7 DRY/WET
This sets the balance between dry and wet signals. This can only be set when variation effects are being used as
insertion effects. It may not be available for use in some cases, depending on the effect type you have selected.

8 FEEDBACK LEVEL
This sets the level at which the signal that is output from the unit is returned to the unit as feedback. By adjusting
the feedback level, you can create oscillation and resonance effects. This function may not be available for use in
some cases, depending on the effect type you have selected.
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9 RETURN
RETURN sets the return level when you are using variation effects as system effects. The return level that applies
to the variation send from each part is adjusted here. This is the same parameter as RTN in the System Variation
unit.

n The variation send from each part can be set by clicking the DETAIL button in the Part Unit, opening the properties
dialog (detail screen) for the part and making the setting on the Pitch, Level page. (This can also be set on the Quick
Edit screen.) The depth of the effect is determined by the combination of the send level and the return level.

) PAN
When variation effects are being used as system effects, this sets the pan. It is the same parameter as PAN in the
System Variation unit.

! To Reverb
To Reverb is the send level to the Reverb unit when variation effects are being used as system effects. It is the
same parameter as to REV (send to reverb) in the System Variation unit.

@ To Chorus
To Chorus is the send level to the Chorus unit when variation effects are being used as system effects. It is the
same parameter as to CHO (send to chorus) in the System Variation unit.

When you click on the close button at the upper-left of the window, the dialog will close and parameter setting
will be finished.

● Detail Screen
You can set many different parameters for Variation Effects.

1. Click on the Type box at the top of the parameters, and a drop-down list will be displayed. Select the effect
type you want to edit from the list.

2. By dragging the slider for each item right and left, you can change the parameter value in each box. You can
also click on the box and enter settings by typing directly from the computer keyboard.

3. When you click on the [Close] button, the dialog will close and parameter setting will be finished.

n The parameters you can set will vary depending on the effect type. For information on each effect type and its
parameters, see the effect type list and effect parameter list in the owner’s manual that came with your XG tone
generator.

23
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System Variation Unit
When you use Variation Effects as System Effects, they are applied equally to all of the XG tone generator
parts (channels).

n When the [SYS] button is on, you can use the System Variation Unit. When the System Variation Unit is gray and can’t be used,
click on the [SYS] button on the System Variation Unit to turn it ON. (It will light up.)

1 INS button
When you click on this button and turn it ON,Variation Effects will be used as Insertion Effects. In that
case, set the parameters for Variation Effects in the Variation Unit previously mentioned.

2 SYS button
When you click on this button and turn it ON,Variation Effects will be used as System Effects. In that case,
you can set the parameters for Variation Effects in the System Variation Unit. At the same time, the Variation
Unit will be gray and can’t be used.

3 TYPE (Effect Type)
The currently selected system Variation Effect type is displayed. Click on the box and a drop-down list will
appear. You can select the effect type you want to use from the list.

n For information about which effect types can be selected, see the effect type list in the owner’s manual that came with your
XG tone generator.

4 PAN knob 
This is used for making Pan settings for system Variation Effects. Set the pan position by dragging the knob
to rotate it. You can also click on the box and directly type in a value from the computer keyboard.

Setting Value L63-C (Center)-R63

5 RTN Fader (Return)
Used for setting the return level for system Variation Effects. Here you can adjust the return level for each
part’s Variation send level. You can set the value by dragging the slider up or down, or by clicking on the
box and entering a value directly from the computer keyboard.

Setting Value 0-127

n To adjust the Variation send level on each part, click on the Part Unit [DETAIL] button, open the Part Properties dialog (Detail
Screen) and set them on the Pitch, Level page (it can also be set on the Quick Edit Screen). The effect depth is determined by
the send level and the return level together.

6 to REV Fader (Send to Reverb)
Used for setting the send level to the Reverb Unit for system Variation Effects. You can set the value by
dragging the slider up or down, or by clicking on the box and entering a value directly from the computer
keyboard.

Setting Value 0-127

7 to CHO Fader (Send to Chorus)
Used for setting the send level to the Chorus Unit for system Variation Effects. You can set the value by
dragging the slider up or down, or by clicking on the box and entering a value directly from the computer
keyboard.

Setting Value 0-127

8 DETAIL button
Click here and the Variation dialog will open. You can set many different parameters for the Variation
Effects. The method for setting them is the same as for the Variation Unit mentioned previously (→P. 21).
Please see there.
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Reverb Unit
Used for selecting the Reverb effect type and making various parameter settings for it. Since the Reverb
effect selected here will be used as a System Effect (→P. 7), its settings will apply to all of the parts of the
XG tone generator.

1 TYPE (Effect Type)
The currently selected Reverb effect type is displayed. Click on the box and a drop-down list will appear.
You can select the effect type you want to use from the list.

n For information about which Reverb effect types can be selected, see the effect type list in the owner’s manual that came with
your XG tone generator.

2 PAN knob 
This is used for making pan settings for Reverb effects. Set the pan position by dragging the knob to rotate
it. You can also click on the box and directly type in a value from the computer keyboard.

Setting Value .................................... L63-C (Center)-R63

3 RTN Fader (Return)
Used for setting the return level for Reverb effects. Here you can adjust the return level for each part’s
Reverb send level. You can set the value by dragging the slider up or down, or by clicking on the box and
entering a value directly from the computer keyboard.

Setting Value .................................... 0-127

n To adjust the Reverb send level on each part, click on the Part Unit [DETAIL] button, open the Part Properties dialog (Detail
Screen) and set them on the Pitch, Level page (it can also be set on the Quick Edit Screen). The Reverb depth is determined
by the send level and the return level together.

4 DETAIL button
Click here and the Reverb dialog will open. You can set many different parameters for each Reverb type.
The method for setting them is the same as for the Variation Unit mentioned previously (→P. 21). Please
see there. The parameters you can set will vary depending on the Reverb type. For information on each
Reverb type and its parameters, see the effect type list and effect parameter list in the owner’s manual that
came with your XG tone generator.
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Reverb Dialog Box
The Reverb dialog box lets you set the parameters for each type of reverb. There are 2 ways to view/edit the
parameters: a Detail screen which lists the exact values of all parameters, and a “Quick Edit” screen which gives
a fast, graphical interface for setting the parameters. Choose “XG Editor Setup” from the MIDI menu and select
“DETAIL” for the detailed view or “Quick” for the Quick Edit view.

● Quick Edit Screen
The parameter value display and setup method are the same as when using Reverb as the Variation effect. See
page 22 for further details. However, the layout of the lower half of the Quick Edit screen is slightly different
from that of the Variation effect. In the Quick Edit screen,you have access to “Return”,“Pan”and “Feedback Level”
parameters. Also, as mentioned above, the “Return” and “Pan” sliders in the Reverb dialog box are the same as
3RTN (Return) and 2Pan. Their settings are mutually dependent.

n The parameters that can be set will vary, depending on the type of reverb. For further details, refer to the lists of effect
types and parameters in the documentation that came with your XG tone generator.

● Detail Screen
The parameter value display and setup method are the same as when using Reverb as the Variation effect. See
page 23 for further details.

n The parameters that can be set will vary, depending on the type of reverb. For further details, refer to the lists of effect
types and parameters in the documentation that came with your XG tone generator.
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Chorus Unit
Used for selecting the Chorus effect type and making various parameter settings for it. Since the Chorus
effect selected here will be used as a System Effect (→P. 7), its settings will apply to all of the parts of the
XG tone generator.

1 TYPE (Effect Type)
The currently selected Chorus effect type is displayed. Click on the box and a drop-down list will appear.
You can select the effect type you want to use from the list.

n For information about which Chorus effect types can be selected, see the effect type list in the owner’s manual that came with
your XG tone generator.

2 PAN Knob
This is used for making Pan settings for Chorus effects. Set the pan position by dragging the knob to rotate
it. You can also click on the box and directly type in a value from the computer keyboard.

Setting Value .................................... L63-C (Center)-R63

3 RTN Fader (Return)
Used for setting the return level for Chorus effects. Here you can adjust the return level for each part’s
Chorus send level. You can set the value by dragging the slider up or down, or by clicking on the box and
entering a value directly from the computer keyboard.

Setting Value .................................... 0-127

n To adjust the Chorus send level on each part, click on the Part Unit [DETAIL] button, open the Part Properties dialog (Detail
Screen) and set them on the Pitch, Level page (it can also be set on the Quick Edit Screen). The Chorus depth is determined
by the send level and the return level together.

4 to REV Fader (Send to Reverb)
Used for setting the send level to the Reverb Unit for Chorus effects. You can set the value by dragging the
slider up or down, or by clicking on the box and entering a value directly from the computer keyboard.

Setting Value .................................... 0-127

5 DETAIL Button
Click here and the Chorus dialog will open. You can set many different parameters for each Chorus type.
The method for setting them is the same as for the Variation Unit mentioned previously (→P. 21). Please
see there. The parameters you can set will vary depending on the Chorus type. For information on each
Chorus type and its parameters, see the effect type list and effect parameter list in the owner’s manual that
came with your XG tone generator.

1

2 3 4

5

27

XG Editor.qx  3/30/99  4:11 PM  Page 27



Chorus Dialog Box
The Chorus dialog box lets you set the parameters for each type of chorus. There are 2 ways to view/edit the
parameters: a “Detail” screen which lists the exact values of all parameters, and a “Quick Edit” screen which gives
a fast, graphical interface for setting the parameters. Choose “XG Editor Setup” from the MIDI menu and select
“DETAIL” for the detailed view or “QUICK” for the Quick Edit view.

● Quick Edit Screen
The parameter value display and setup method are the same as when using Chorus as the Variation effect. See
page 22 for further details. However, the layout of the lower half of the Quick Edit screen is slightly different
from that of the Variation effect. In the Quick Edit screen, you have access to “Return”,“Pan”,“to Reverb” and
“Feedback Level” parameters. The “Return”,“Pan” and “to Reverb” sliders in the Chorus dialog box are the same
as in the Chorus unit.

n The parameters that can be set will vary, depending on the type of chorus. For further details, refer to the lists of effect
types and parameters in the documentation that came with your XG tone generator.

● Detail Screen
The parameter value display and setup method are the same as when using Chorus as the Variation effect. See
page 23 for further details.

n The parameters that can be set will vary, depending on the type of reverb. For further details, refer to the lists of effect
types and parameters in the documentation that came with your XG tone generator.
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Equalizer Unit
Equalizing (tone adjustment) settings that affect all of the parts of the XG tone generator are made in the
Equalizer Unit. It has a graphical-style equalizer interface that lets you adjust the gain for five frequency
bands. There are also several different types of preset equalizer settings that you can choose from. Just by
making slight adjustments to one of those types, you can easily set up the equalizer for any situation. If you
want to make more detailed settings, you can click on the detail button and open the EQ dialog.

n Depending on your XG tone generator, some or all of the equalizer settings here may be incompatible. See the MIDI data format
in your XG tone generator owner’s manual.

1 TYPE (EQ Type)
The currently selected equalizer type is displayed. Click on the box and a drop-down list will appear. You
can select the equalizer type you want to use from the list. The settings for each band in the equalizer type
you selected will be displayed as a bar graph.

n There are five equalizer types you can choose from: FLAT, JAZZ, POPS, ROCK and CONCERT. Depending on your XG tone
generator, there may be an EQ type identified as “CLASSIC” in the MIDI data format of the owner’s manual. The “CONCERT”EQ
type available here is equivalent to it.

2 Bar Graph Display
The equalizer gain settings for each band are displayed here as a bar graph. The gain settings for each band
are shown by three of the fifteen bars. The three bars farthest on the left correspond to Band 1, while the
three farthest on the right correspond to Band 5. The bars show the gain of each frequency. As each bar
gets longer, the gain is larger. As the bar gets shorter, the gain is smaller.

3 FREQ (Frequency)
The frequency of the currently selected band is displayed. By clicking on the box, you can directly enter
a value by typing on the computer keyboard, and set the frequency for that band. For information about
the possible frequency settings for each band (1-5), see the MIDI Parameter Change Table (MULTI EQ), in
the MIDI data format of the owner’s manual for your XG tone generator.

4 BAND (Frequency Band) knob
Use this to select the band you want to adjust the settings for, from among the five equalizer bands. The
band number will be displayed in the box as you drag the knob and rotate it. If you click on the box, you
can type in the band number directly from the computer keyboard. The frequency of the currently selected
band will be displayed in the FREQ box.

Setting Values...................................1-5

5 Frequency Select slider
By moving this slider left and right, you can choose the frequency for the currently selected band. The
frequency you select will be displayed in the FREQ box.

n For information about the possible frequency settings for each band (1-5), see the MIDI Parameter Change Table (MULTI EQ),
in the MIDI data format of the owner’s manual for your XG tone generator.

1
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6 GAIN knob
This is used to adjust the gain of the currently selected band frequency. As you rotate the knob by dragging
it, the value will be displayed in the box. If you click on the box, you can type in the gain directly from the
computer keyboard. The results of your gain adjustments will appear in the bar graph display in realtime.
As you increase the gain, the frequency band will be emphasized, and a peak will appear on the bar graph
display. On the other hand, if you decrease the gain, the frequency band will be lowered, and a valley will
appear in the bar graph.

Setting Values...................................-12 to 0 to 12

Equalizer Adjustment
Follow these steps to adjust the equalizer:

1. Select the equalizer type with the TYPE box.

2. Select the frequency band you wish to adjust, using the BAND knob.

3. Use the either the Frequency Select slider or the FREQ box (whichever suits your purpose) to set the
frequency you want to adjust.

4. Make adjustments using the GAIN knob.

5. As necessary, repeat steps 2-4 above and adjust the gain for other frequency bands.

7 DETAIL button
Click here and the EQ dialog will open.

EQ Dialog
You can set various parameters for each equalizer type.

1. Click on the Type box at the top of the parameters, and a drop-down list will be displayed. Select the
equalizer type you want to edit from the list.

2. By dragging the slider for each item right and left, you can change the parameter value in each box. You can
also click on the box and enter settings by typing directly from the computer keyboard.

3. When you click on the [Close] button, the dialog will close and parameter setting will be finished.

n For information about equalizer parameters, see the MIDI Parameter Change Table (MULTI EQ), in the MIDI data format
of the owner’s manual for your XG tone generator.
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Assigning Insertion Effects and Drum Setups to Each Part
Insertion Effects and drum setups are assigned to each part as needed. The parts assigned with Insertion
1 and 2 effects can have not only systems effects, but can also independently use the Insertion Effects 1
and 2. Also, the part assigned with a Variation Effect can use it when the Variation Effect is used as an
Insertion Effect. (Each Insertion Effect can be assigned to one of the parts.) The drum parts assigned with
drum setups will reflect the settings made in the Drum Unit.

n You can assign the same or different drum setups to multiple parts. The types of setups you can use will vary according to your
tone generator.

To make assignments, drag the appropriate icon for the Variation Unit, Insertion 1 Unit, Insertion 2 Unit, or
Drum Unit to the part box where you want to assign it and drop it there, as in the picture.

To change assignments, drag the appropriate icon in the Part Unit and move it to another box. To clear
assignments, drag the appropriate icon to the outside of the Part Unit and drop it there.

Changing Canceling
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Menu Bar
XG Editor has 7 menu bars.
The most commonly-used commands are available as buttons on the XG Editor. (→P.7)

n Commands/functions may sometimes be unavailable and grayed-out, depending on the window or the operation you are
performing.

Apple Menu

About XG Editor...
This is the same screen as the XG Editor startup screen.

File Menu

Open: ( O)
This opens the “Select File” dialog box.
Here, you can open SMF files (including XF files) or Parameter files.
When you choose a file from this dialog box, the XG parameter data is read and XG Editor’s windows are
updated with the new values.

Save Parameter: ( S)
This overwrites and saves the currently open file in Parameter file format.
An Alert message appears if a song file is currently open and since it will be overwritten with a Parameter-
only file.
In the case of a new file, the following “Save As...” dialog box appears.

Save as...
This allows you to name and save the currently open file as a Parameter file.
An Alert message appears if a song file is currently open and since it will be overwritten with a Parameter-
only file.

Insert in SMF
This adds additional XG parameter data to the currently open song data, then saves the file in SMF format.

Quit: ( Q)
This closes XG Editor. If the currently open file has not been saved, or if the default settings have been
altered,an Alert message will appear confirming whether you wish to save the file before closing XG Editor.
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Edit Menu
Use this menu when you need to input or copy data.

Cut: ( X)
This is used to move selected sections of displayed text or data to the clipboard.
If nothing has been selected, this command is grayed out.

Copy: ( C)
This is used to copy selected sections of displayed text or data to the clipboard.
If nothing has been selected, this command is grayed out.

Paste: ( V)
This is used to copy the text or data from the clipboard to the selected position on the display.
If a location has not been specified, this command is grayed out.

Clear
This is used to delete selected sections of text or data. If nothing has been selected, this command is grayed
out.

Copy As Data...: ( B)
This is used to copy the XG addresses and data from the selected XG parameter data to the clipboard. XG
parameter data can be pasted to any clipboard-compatible software. (→P.49)
If nothing has been selected, this command is grayed out.

Show Clipboard...
This is used to show the contents of the clipboard.
XG parameter data copied using “Copy As Data...” is shown in hexadecimal. (Values F0 and F7 are not
shown.)
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MIDI Menu

XGEditor Setup
This opens the XG Editor Setup dialog. For details, see page 5.

Assignable Setup
This sets the parameters assigned to the part unit assignable sliders and buttons. For details, see page 14.

OMS Port Setup
This opens XG Editor’s OMS Port Setup screen.
Read the “OMS Port Setup” section on P.4 for further details.

OMS MIDI Setup
This opens the OMS MIDI Setup screen.
Refer to the OMS User’s Manual for further details.

OMS Studio Setup
This starts up OMS Setup and opens the Settings screen.
Refer to the OMS User’s Manual for further details.

Receive XG Bulk...
This opens the Receive XG Bulk dialog. For details, see page 44.

Transmit XG Parameter: ( M)
If the XG parameters have been changed from their default values, this command can be used to send all
data changes to a tone generator or another application. No window will be opened.
The Send Interval can be set in the “XG Editor Setup”, and the port to be sent to can be set in the “OMS
Port Setup”.

Transmit XG System On: ( N)
This transmits XG System ON message to the connected XG tone generator. The port to be sent to can be
set in the “OMS Port Setup.” No window will be opened.

Parameter Reset: ( R)
This transmits All Parameter Reset message to the port selected in the “OMS Port Setup”, and
simultoneously clear settings of XG Editor. No window will be opened.
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Window Menu
Use this menu to open each DETAIL window.

SYSTEM: ( 1)
This opens the System Parameter dialog box. (→P.15)

PART: ( 2)
This opens the Properties dialog for Parts [1-16], [17-32], [33-48], [49-64] and [A/D or Audio] as selected in
the Part unit.

DRUM SETUP: ( 3)
This is used to open the Drum properties if Drum sets 1 to 4 (DRUM S1-S4) are selected in the Drum unit
setup.

EFFECT
This opens the DETAIL windows for all Effects.

REVERB: ( 4)
This opens the dialog box for the Reverb unit. (→P.25)

CHORUS: ( 5)
This opens the dialog box for the Chorus unit. (→P.27)

INSERTION 1: ( 6)
This opens the dialog box for the Insertion 1 unit. (→P.19)

INSERTION 2: ( 7)
This opens the dialog box for the Insertion 2 unit. (→P.21)

VARIATION: ( 8)
This opens the dialog box for the Variation unit. (→P.21)

MULTI EQ: ( 9)
This opens the EQ dialog box for the Equalizer unit. (→P.29)

Keyboard
This opens the Keyboard panel screen.
Read the “Keyboard” section on P.41 for further details.
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Option Menu
Use this menu to make changes in the Select box or User Entry window. Read the “Select Box” section on
P.42 and the “User Entry Window” section on P.43 for further details.

Transmit Selectbox Data: ( J)
This transmits all the parameters in the Select Box.

Add to Selectbox: ( K)
This adds the parameters selected in the Main Panel to the Select Box.

Open Selectbox: ( L)
This opens the Select Box window.

User Entry Dialog: ( T)
This opens the User Entry window.

Player Menu
Use this menu to control the 64 Part-compatible XGPlayer.
Read the “XGPlayer” section on P.37 for further details.

XGplayer: ( G)
This opens the Player Panel screen.

Select Song...: ( H)
This opens a dialog box for selecting from a list of song files to be played back in the Player.
Selection is possible while the Player panel is open.
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XGPlayer
Use this to play back SMF-format song data, XF-format songs, data for karaoke and songs created with
XGworks for Windows 95/98 (with the extension .XWS).
Click the icon on the Main Panel or choose “XGPlayer”from the Player menu ( + G) to open the Player
panel. To open the Mixer Panel, click the Mixer button on the Player Panel.

● 64 Part-compatible player.

● 16 Part mixer.

● Up to 25 songs can be played back in sequential or random order.

● Tempo Change and Key Control functions are also supported.

● Song files in SMF-format or XF-format, or song files written in XGworks for Windows 95/98 (with the
.XWS extension) can be played back.

● You can adjust a song’s parameters in real-time using XG Editor.

● The MIDI signal is transmitted via OMS. Each block is automatically assigned to the corresponding ports
(MIDI OUT A - D) set in the “OMS Port Setup” (see P.4). When using up to 64 Parts, set the outputs of
the four Ports according to the example on P.4 with a MU128 module.

● If the virtual memory is turned on in the Macintosh, it may cause problems when playing backs songs in
XGPlayer. Turn off the virtual memory when using XG Editor.

n • Although the XF-format is supported, lyrics for karaoke songs will not be displayed.

• XGPlayer assigns a track to each Part’s MIDI channel. Therefore, if data for the same MIDI channel exists in multiple tracks,
the song data will not be played back properly. This is the case for SMF Format 1 and XWS files.

• The network extension files in Mac OS may cause problems when playing back songs files in XGPlayer. Always switch
AppleTalk OFF before using XG Editor.

• If the virtual memory is turned on in the Macintosh, it may cause problems when playing back songs in XGPlayer. Turn off
the virtual memory when using XG Editor.

Player Panel

Mixer Button

Mixer Panel
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Names and Functions of Features: Player Panel

Playback Control buttons
Use these when playing back songs.

(Play button).......................Click this to begin song playback.

(Pause button) ....................Click this to pause the song during playback. Pressing will resume
playback from that point.

(Stop button) ......................Click this to stop song playback. Pressing will begin playback from
the start of the song again.

(Review All button) ............Click this to return to the first song in the queue.

(Review button) .................Click this to jump to the beginning of the previous song in the queue.

(Cue button) .......................Click this to jump to the beginning of the next song in the queue.
MANUAL (Manual button) ........Click this to play back just the selected song.

AUTO (Auto button)..................Click this to play back the songs from the song list in the order in which
they were selected.

R (Random Playback button) .....Click this to play back the songs from the song list in a random order.

Song display
This shows the name and number of the current song.

Song Queue mark
marks represent the songs queued in the song list and a mark indicates the current song.

Tempo Change buttons
Use these to change the playback tempo. Use the Up and Down buttons to change the tempo by +/- 4
levels (+/- 5/10/20/40%).

Key Control buttons
Use these to change the playback key. Use the Up and Down buttons to change the key by +/- 4 semitones.

Sliders
Use these to adjust the following parameters. A parameter’s value is 0 when its respective slider is at the
bottom, and increases as it is moved up.

VOL (Volume) ............................Use this to adjust the playback volume during song playback.

REV (Reverb) .............................Use this to adjust the amount of reverb applied during song playback.

CHO (Chorus)............................Use this to adjust the amount of chorus applied during song playback.

VAR (Variation Effect)................Use this to adjust the amount of variation effect applied during song
playback.

n The Variation slider only has effect when a Variation Effect is being used as a System Effect.

Power button
If you click this, the current song is stopped and the Player is closed together with the Mixer panel.

Song display
Song Queue mark

Power button

Playback Control buttons Tempo 
Change 
buttons

Mixer 
button

Key 
Control 
buttons

Song 
Select 
button

Sliders
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Song Select button
Click this to open the Song Select list dialog box. (see below)

Mixer button
Click this to open the Mixer panel. (→P.40)

Song Select list dialog box
Click the Song Select button on the Player panel or choose “Select Song...” from the Player menu (Command + H)
to open the Song Select list dialog box.
This opens a screen where you can add songs to the song list for playback by Player.

1. Choose the folder containing the song files and select the files to add to the file list.

n Only files which are compatible with Player will be shown.

2. • Choose a song file and click the Add button to add it to the song list. Alternatively, just double-click the
song file.

• Add all song files in the current folder to the song list by clicking the Add All button. If there are over 25
songs, the first 25 will be added.

• Delete a song file from the song list by selecting it and clicking the Delete button.

• Delete all songs from the song list by clicking the Delete All button.

3. When you have compiled your song list, click the Finish button.
If you click Cancel, all changes to the song list will be cancelled and Player will return to the state prior to
opening the Song Select list dialog box.

n • The song file list compiled here will be active until you quit XG Editor.

• If your song list includes song files which exist on a network, you may encounter errors during playback
depending on the network conditions.
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Mixer panel

BLOCK (Part Block selector button)
Use this to choose which block of 16 Parts (out of 64 Parts) is shown.

VOL. (Volume)
Use this to adjust the volume of each part.

PAN
Use this to select one of 7 pan positions for each part.

SOLO, MUTE

SOLO................................................If you click one of these buttons during playback, it will turn orange and
the respective Part will be heard on its own.

MUTE ...............................................If you click one of these buttons during playback, it will turn green and
the respective Part will be silenced.

n SOLO and MUTE can be set independently. If SOLO and MUTE are set for the same Part, SOLO is given priority.

Level Meters
These display the levels of each Part as seven-segment meters.

GM ON button
Click this to transmit a GM System ON message.

XG ON button
Click this to transmit a XG System ON message.

MIDI Reset button
Click this button to send an All Notes OFF and Reset All Controllers message.
Use this if you encounter a malfunction during playback or if behaviour becomes abnormal.

Level Meters

Solo/Mute

Pan

Part Block
 selector button

Volume

GM ON 
button

MIDI 
Reset 
button

XG ON 
button
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Keyboard
This panel is displayed when you click the Keyboard icon on the Main Panel or choose “Keyboard” from
the Window menu.
If you click a key on the on-screen keyboard, the voice assigned to the specified Part is played back. Use
this when monitoring and editing voices.

Keyboard Panel

Close box
This closes the Keyboard panel.

Part box
This shows the selected Part.

Up/Down buttons
Use this to change the selected part.

Voice name
This shows the voice assigned to the selected Part.
You cannot change the voice assignment here. You can change the assignment in the Part unit. (→P.8)

Select Octave buttons
The range of the keyboard is usually from C2 to C5. Use this button to shift the range up or down by up
to 2 octaves.

Mono/Chord selector button
Mono .........................................When you click a key using the mouse,a single note is played back. This

feature is useful for creating glissando effects.

Chord ........................................When you click a key using the mouse, a chord is played back using the
key as the root. You can also select the desired code type in the Code
menu. You can also select the desired chord type in the Chord menu.

Mono/Chord 
selector button

Chord menu

Close box Part box Voice name

Keyboard

2 Octaves Up

Select Octave buttons

1 Octave Up
Normal

1 Octave Down

2 Octaves Down

Up/Down buttons
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Select Box
This can be used to store some MIDI messages. You can send the message you want by selecting the
appropriate box.

Select Box display
Choose “Open Selectbox” from the Options menu to display the Select Box.

List window
This shows the stored parameters.

Name/XG Message selector
Use this to choose whether to display List window parameters in
parameter name or hexadecimal MIDI message format.

Delete button
Roll the mouse over the parameters in the List window to select,
then click the Delete button to delete them.

Clear button
Click this to clear the contents of the List window.

Save button
Click this to save the contents of the List window as a Parameter file.

Storing in the List Window
You can store parameters in the List window in the following two ways:

• Click the desired parameter in the Main Panel, then click the button on the main panel.

• Click the desired parameter in the Main Panel or Detail screens, then choose “Add to Selectbox” in the
Options menu ( + K).

n On the Quick Edit screens, non-selectable parameters cannot be stored.

Sending Parameters in the List Window
You can send all the parameters in the List window to the MIDI Out (the OMS output port) in the following
two ways:

• Click the button on the Main panel.

• Choose “Transmit Selectbox” from the Options menu ( + J).
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User Entry Window
You can use this to assign up to 16 different system exclusive message to the buttons on this window, and
to send them. It is convenient for storing model-specific messages, XG parameters, universal messages, and
so on.

User Entry window display
Choose “User Entry Dialog” from the Option menu.

Bank buttons
Use these to store up to 16 messages you wish to send. They can be in one of three states:

Gray...........................................Data is not stored.

Blue ...........................................Data is stored.

Blinking ....................................Currently selected message.

n A button will turn blue once any data, even a single character, is entered.

Name
Enter the parameter/message name here.

Message
Enter the system exclusive message here in hexadecimal.

• After entering the Name and Message into the text boxes, press Return to confirm.

• You can enter long messages by double-clicking on the message box to enlarge it.

Clear button
Click this to clear all the messages stored in the Bank.

Send Data
Click this to send the messages stored in the selected Bank to the MIDI Out.

n Messages stored here cannot be saved as a file. However, they are stored in the initialization file and will be available the next
time XG Editor is started up.

Bank button
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Receive XG Bulk
You can send setup data from your XG tone generator to XG Editor as XG Bulk data. Click the Receive XG
Bulk button on the Main panel or choose “Receive XG Bulk...” from the MIDI menu to begin receiving XG
Bulk data.

How to use Receive XG Bulk
Before receiving XG Bulk data, you will need to make the following setting in OMS Port Setup (→P.4)
As an example, the following explains how to set up OMS for an MU128 tone generator.

MIDI In
If you are connecting an XG tone generator to the modem port, choose “MIDI Time Piece-Modem.”*  If you
are connecting an XG tone generator to the printer port, choose “MIDI Time Piece-Printer.”*
*If you choose “MU128-1” through “MU128-4” or “XG Editor” here, you cannot receive XG Bulk data.

MIDI Out A
Choose “MU128-1” and check the “On/Off” checkbox.

MIDI Outs B to E
Uncheck “On/Off” checkboxes.

n Choose “XG-16part” for MIDI In and MIDI Out if you are using a 16 Part-compatible tone generator.

1. Click the Receive XG Bulk button on the Toolbar.The Receive XG Bulk dialog will open.

n This dialog can also be opened by selecting [Receive XG Bulk...] from the [MIDI] menu on the Application Window menu bar.

2. In the Dump Request section, select the receive bulk method. Then for the Receive XG Bulk process,

check the “On/Off” checkbox to send a dump request message from XG Editor to the connected XG
tone generator. If you do not check the “On/Off” checkbox, you will need to initiate the Receive XG
Bulk process from the XG tone generator.

3. If the “On/Off” checkbox has been checked, click on the Type text box and select the type of dump

request from the drop-down menu. If it has not been checked, nothing will be selectable in the Type
text box.

4. If the “On/Off” checkbox has been checked, click the Start button to send the specified dump request

command to the connected XG tone generator and begin the Receive XG Bulk process. If it has not
been checked, you will need to initiate the Receive XG Bulk process by issuing a bulk dump from the
XG tone generator. You can check the receiving status of the operation by looking at the bar display
in the Receive XG Bulk dialog. If the “On/Off” checkbox has been checked, the Receive XG Bulk
process will complete when the bar display reaches the end. You can terminate the operation at any
point midway by clicking the Stop button. If the “On/Off” checkbox has not been checked, XG Editor
will be ready to receive data from when the Start button is clicked to when the Stop button is clicked.
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5. When you click the OK button, the dialog box will close and the Receive XG Bulk operation will be

complete.
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About File Formats
Opening Files
You can open files in XG Editor by choosing “Open...” from the File menu.
Two kinds of files can be opened: Parameter files (SYX format) and SMF files (including XF).
When you open one of these files, the XG Editor screen is updated with the parameters contained in it.

• Both Format 0 (including XF) and Format 1 SMF files are supported.

• Bank Select, Program change and other GM messages are reflected in the XG Editor screen but cannot
be saved.

• The following system exclusive messages are not supported in XG Editor:

System information

Display data

Performance Mode parameters

Model ID-specific MIDI transfer parameters

• Files of the wrong format or with incorrect contents will not be recognized or opened.

n XWS files cannot be opened.

Saving Files

Saving Parameter files:
XG parameter data can be saved in Parameter file or SMF file format.
Choose “Save Parameters” from the [File] menu and save by overwriting the existing file.
Choose “Save As...” from the [File] menu, enter a different name for the file and save. This is useful when
creating or renaming files.

• Up to 1000 XG parameters (including original data) can be saved.

• Parameter files are saved as “XGPR” files and SMF files as “Midi” files.

• You can name files as you wish. The default is “untitled.xgp”, or “untitled.mid” for SMF files.

Saving to SMF
Choose “Insert in SMF” from the File menu, then save.
XG parameters that have been altered are saved to the original file in SMF format.

• Up to 255 XG parameters (including original data) can be saved.

• Choose “XG Editor Setup” from the MIDI menu to set the interval between parameter events (delta
time). The range is 1 to 255.

Ex.) For a 120 bpm song with a resolution of 480, if you set the parameter interval to 48 ticks (30 in decimal),
the actual interval will be about 50 ms.

• Insert GM On and XG On messages in the header, then about 50ms later, the XG parameters.

• XG parameters are inserted in track 1 of a SMF Format 1 file.

n This feature is intended for saving XG parameter data. Song data may play back incorrectly depending
on the existence and timing of MIDI events.Files that have been saved using “Insert in SMF” should be
opened and saved in your sequence software before being edited further.

n Files cannot be saved in XWS format. Also, when opening and playing back XWS files using XGPlayer, their parameters will be
reflected in the XG Editor screen but can only be saved as Parameter or SMF files. MIDI events other than XG parameters will
not be saved.
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Sending Data from XG Editor to an OMS-compatible Sequencer
You can add XG parameter data to song data created on other sequencers in the following ways:

1. Real-time Recording: Record the XG parameters in real-time through the interaction between OMS

applications.

2. Clipboard Copy/Paste: Copy XG parameters and paste them as text data one at a time.

3. Insert in SMF: Save parameter data as an SMF, then open it in another sequence software.

1. Real-time Recording

1-1. Using the Sequencer’s Internal Port
You can record in real-time to an OMS-compatible sequencer with internal ports as follows:

Procedure
First, start up XG Editor and your OMS-compatible sequencer.
If OMS has not been set up, follow “How to Set Up OMS” (→P.4) to complete the process.

1. Choose “OMS Port Setup” from the MIDI menu, assign “MIDI Out E” to the sequencer’s internal port,

check the “On/Off” checkbox and close the window. (→P.4)

2. Switch to your sequencer’s screen.

3. In your sequence software, select XG Editor as an input device.

4. Select a track to be recorded on your sequencer and start recording in real-time.

5. Immediately switch to XG Editor.

6. Now, changes made to XG Editor’s parameters will be recorded in real-time on your sequencer.

To record changes in bulk, choose “Transmit XG Parameter” from the “MIDI” menu. (→P.34)

7. If necessary,choose “XG Editor Setup”from XG Editor’s MIDI menu to change the transmission interval.

(→P.5)
If the transmission interval is short, mouse movement is improved but the number of unnecessarily
transmitted parameters is also increased. Also, the data will be too closely packed, making it difficult
to edit the data in your sequencer.
If the transmission interval is too long, mouse movement is impaired and the time to transmit
parameters is increased.

Ex.) Use the following recording settings as a guideline:
At a sequencer resolution of 480 bpqn, a tempo of 75 bpm and a transmission interval of 1, the recording interval
is about 10 ticks.
Generally, when continually inputting XG parameters, a recording interval of at least 5 ticks is necessary.

n When sending parameter changes to an SMF containing no XG parameters or to a new file, an “XG System On”message must
be added to the head of the song data.
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1-2. Using the OMS IAC Driver
If your OMS-compatible sequencer has no internal port, you can use the OMS IAC driver supplied
with OMS.

Procedure

1. Choose “Custom Install” in the OMS installer and install the OMS IAC Driver.

2. After installation, check that the OMS IAC Driver exists in the OMS folder within the System folder.

3. Reboot your Macintosh.

4. Connect your tone generator and switch it on.

5. Start up the OMS Setup program within the “OMS Applications” folder, then choose “MIDI Cards &

Interfaces” from the Studio Menu.

6. Click the “Update Setup” button.

7. Check that the port you wish to use has been selected, then press the Search button.

8. Check that the “IAC Driver” device has been detected, choose “Save As...” from the File menu, assign a

name and save. This setup process is now complete.

9. Close OMS Setup.

10.In XG Editor, choose “OMS Port Setup” from the “MIDI” menu, assign “-IAC Bus #1” to MIDI Out E and

check the “On/Off” checkbox.

11.Switch to the sequencer screen.

12.At the screen to choose the input device, choose the “-IAC Bus #1” port. Refer to your sequencer’s

documentation for further details.

13.Close the dialog box.

Hereafter, follow procedure for recording XG parameters is the same as for real-time recording. (→P.47,
step 4 onwards)
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2. Clipboard Copy/Paste 
An OMS-compatible sequence software is assumed in the following example.

Procedure
First, start up XG Editor and your OMS-compatible sequencer.

1. On any XG Editor screen, click on a box to which a parameter has been assigned. (The box will turn

light blue when selected.)

2. Choose “Copy As Data...” from XG Editor’s Edit menu. Alternatively, click the button.

3. Verify the contents of the clipboard by choosing “Show Clipboard...” from the Edit menu.

4. Paste the XG parameter data to your sequencer.

n This procedure can be used with any clipboard-compatible software.

3. Insert in SMF

1. In XG Editor, make the necessary parameter settings and choose “Save as...” from the “File” menu.

(→P.32)

2. In the Save File dialog box, select SMF (Format 0), assign a name and save.

3. You can now open the file in another sequence software, copy it to some other song data or edit it in

other ways.
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Troubleshooting
If you encounter problems such as no sound output or abnormal behavior, verify the connections before
checking the following.

Can’t install the program
• Do you have sufficient free hard disk space, memory and other necessary hardware? Verify your

hardware setup one more time. You will be unable to install software if do not have sufficient free hard
disk space. Delete unneeded files to free up space.

The program doesn’t start up
• Check your hardware setup (memory and so on). The program may not start up if your computer has

less than 8 MB of free memory available.

• XG Editor will not start up if OMS has not been installed. Verify that OMS has been installed.

• Verify that all the necessary files have been installed. If files are missing, completely reinstall the
program from disk.

• There may be a conflict with another INIT file or utility program. Check that there are no strange or
possibly problematic programs in the System extensions or Control Panel folder.

• If an application is already using the serial port, XG Editor may not start up. Close that application’s
driver.

An error message appears when starting up the program or the startup settings are strange.
• The file supplying the parameter information (“___.ini”) may have become corrupted. If there is an

error message, copy the original file from your CD-ROM.

• The startup file containing the initial settings may have become corrupted. Open the Preferences folder
within the System folder, then drag “XG Editor2.pref” to the Trash Can and reboot.

The computer frequently locks up or crashes while using the program.
• There may be problems when using a computer with little memory for long periods of time. Fit as much

memory as possible to your computer and increase the amount of memory assigned to the application.

• If the connections with your tone generator are incorrect, OMS can cause a data overflow when MIDI
data is transmitted. Check the OMS setup and the connections with your tone generator.

The printer port is not recognized.
• The printer port will not be recognized if AppleTalk is ON. Note that with some Macintosh models,

AppleTalk is automatically enabled when starting up.

• Verify that the “Printer” checkbox has been checked in the OMS MIDI Setup window.

The modem port is not recognized.
• On some Macintosh models such as the Performa series, the modem port cannot be used and only the

printer port is available.

• Verify that the “Modem” checkbox has been checked in the OMS MIDI Setup window.

No MIDI Out data
• In the OMS Port Setup, is MIDI Out set to “unknown”? If you change the OMS ports or setup, the OMS

output ports have to be set accordingly in XG Editor’s OMS Port Setup window. Choose the appropriate
receiving device and check the “On/Off” checkbox.

• Is OMS using the same port as that connected to the cable? Open the OMS MIDI Setup window and
verify that the checkbox for the relevant port has been checked.

• If the port and setup assignments are frequently altered, OMS may be unable to easily recognize the
serial port. Reboot the Macintosh, set up OMS correctly, then start up XG Editor.
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Can’t hear the sounds in Parts 17 to 64 using the Click Monitor in the Keyboard and Voice List windows.
• Open the OMS Port Setup window and verify that the output ports have been checked for “Multiport.”

(→P.4)

• When OMS has been set up to use a Standard Interface, only Parts 1 to 16 can be auditioned.

The data shown in XG Editor differs from that shown in the tone generator display.
• Voice and Parameter names displayed in the tone generator are abbreviated due to the limited screen

size.

XG Editor will not open a file.
• Files with incorrect contents or format cannot be opened. (→P.46)

• XWS files cannot be opened.

Can’t open the SMF when using “Open”
• Change the SMF file type to “Midi,” then try opening it again. (→P.46)

XG Editor does not show all the parameters of the Parameter file or SMF file.  
• Some parameters are not supported in XG Editor. (→P.46)

Can’t send parameters changed using “Transmit XG Parameter” or “Save as...”
• Parameters cannot be sent if they have pre-defined default values in XG, even after changes have been

applied.

• Parameters stored in the User Entry window are not included.

Bulk data are not received.
• Check the connections with your tone generator.

• Open the OMS Port Setup window and check that the MIDI In has been properly assigned. (→P.4)

• Open the “OMS MIDI Setup”window from the MIDI menu,check the serial port, then close the window.
(A Port Reset message is sent when you do this.)

• Open the XG Editor Setup window and adjust the transmission interval. (→P.5) Bulk Receive may be
unreliable if you do not extend the dump request interval.

Can’t send data to my sequencer.
• Check the OMS Port Setup in both XG Editor and your sequence software. (→P.4, 47)

Can’t play back properly in XGPlayer.
• Check your OMS Port Setup. (→P.4)

• Check the file format of the song data. (→P.46)

• The track format of the song may be incompatible with XGPlayer. Use a different sequence software.

An error occurs during playback in XGPlayer.
• Switch Virtual Memory OFF.

• Switch AppleTalk OFF

• Check the contents of the song data.

Preset Data cannot be set up properly.  Also, sample phrases are not played back.
• Check the OMS Port Setup. (→P. 4)

• Preset Data cannot be used while XGPlayer is playing back a song.

• Check that the template files exist in the Preset folder (which can be found within the XG Editor folder.)
If files are missing, reinstall the program from disk.

• Some tone generators are incompatible with the Preset Data parameters (the Insertion Effects, etc.)
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